The Miller Group University of North Carolina at Chapel Hill

Standard Operating Procedure

Task: Using OceanView’s File Writer and Importing Data to Excel
Created by: Miller Group
Date: 5/11/2017

Background:

e When investigating kinetics or intermediates in reactions by UV-Vis, it is often
convenient to set up a File Writer for OceanView to automatically collect spectra. When
the entire spectrum is collected, each time point is saved in a separate tab-delimited
text file. A macro to import these files into Excel is included.

Training Requirements:
e Lab Safety Training
e UV-Vis Training

Potential Hazards:
e Hazards associated with a UV-Vis experiment

Special PPE Requirements:
e None

Materials Needed:
e Materials for your experiment
e OceanView
e Excel

Procedure:

This SOP includes Setting up a File Writer, Making a Strip Chart, and Importing Data to Excel.
e The file writer example is shown for recording full absorbance spectra, but an analogous
file write can be configured for any tab in OceanView. For example, a single wavelength
can be monitored by making a strip chart and using a file write on that tab.
e Importing Data to Excel is specific to full absorbance spectra from OceanView.

Setting up a File Writer

1. Set up an absorbance spectrum as usual. Note: it's good practice to configure your file
writer before running your sample of interest and ensure that the data is saving as
expected. If OceanView is not close, the same file writer configuration can be used
multiple times.
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2. Select “configure graph saving”

ﬂ OceanView 1.3.4 (Licensed)
File Window Help

ARESRG
|22 view_1 52| [ AbsorbanceView_16 sel
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3. Click “Yes”

Nindow ﬁFavorites h

4. Fill out the form to save spectra with desired frequency (e.g. 30 s below). The Writer
can be configured to stop automatically after a given amount of time or scans, or can be

manually ended. Make a new directory to save files to. Use “Tab separeated with
Headers.”

fa B
Algorithm Parameter Controls &J

File Writer_11 (File Writer)
Input A: Aggregate_10

Save Options File Options

(7) Save every scan:

(©) Save after every: 100 || scans
(©) Between saved scans, wait at least: SIS EELRE E]
100 = [sec C:\Users\barretts\Documents\Data\Kate Pitman\CP-VI-092
@ Save the first available scan every: File Format: Tab separated with Headers |
30 % sec v Padding Digits: 5K
[7] Start at the beginning of the next:iminute = BaseName:
Preview : viewdata01234.txt

[V] Stop after this many scans: 5| = Siafac s

[] Stop after this amount of time:

60 || sec

5. Click “Apply” and “Exit”



The Miller Group University of North Carolina at Chapel Hill

6. Select either “Start all file writers” or “Save graph to file/files” to begin recording data.

ﬂ OceanView 1.3.4 (Licensed)
File Window Help —

AR S =(G)
[E view_1 s[EY AbsorbanceView_16 |
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RN

Note: multiplé types off file writers can be cohfigured at once. You'could, for éxample,
record single wavelength data (below) while recording the entire spectrum. If multiple
file writers are configured, use “start all file writers” in the top left corner.

Nindow ﬁFavorites h

7. The spectra are saved to the set directory. See below for importing into Excel.

5 SRNCH X
@Qv‘ » Libraries » Documents » Data » KatePitman » CP-VI-092 kv|#’,|| ; CP-VI-092 ,O‘
Organize ¥ Share with v Burn New folder =~ 0 @
.:a;or:tes E)pqg;;grpents library Arrange by:  Folder v
esktop Sidnlol
:'A Recent Places Name ’ Date modified Type Size

& Downloads

. Absorbance_00001 Text Document 40 KB
o Absorbance_00002 Text Document 40 KB
4 Libraries L
= Absorbance_00003 Text Document 40 KB
| Documents =
N - Absorbance_00004 Text Document 40 KB
JrMUﬂc = -
. Absorbance_00005 Text Document 40 KB
= Pictures o
B Videos
Making a Strip Chart
S I « H h ”
1. elect “create strip chart
ﬂ OceanView 1.3.4 (Licensed)
File Window Help
A, Paa
L /]
AREORG
|22 view_1 52| [ Absorbanceview_16 sel

il 2 4+ 1 AQQQAQY o@mhal ® ) 8\ (9@

Nindow ﬁFavorites h
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2. Select Spectrum Type = Absorbance (101 is the instrument’s raw data). Click Next
S=5)

-
[A] Strip Chart Wizard

Source Selection (1. from 5)

Steps

1. Source Selection _Source Selecti

2. Update Rate

3. Wavelength Selection # Spectrometer Spectrum Type
4. Select Numerator 101 Device:USB2+H14038 Acquire_1

5.  Select Denominator Device:USB2+H14033

Wavelength Selection

(@ Range Selection (©) Ratio of Wavelength

Information

Create a time series strip chart from a single wavelength
or range of wavelengths. A ratio of wavelengths can also be used.

3. Select refresh rate and when to stop recording (typically update after every scan and
never stop) Note: this does not save the data. It just displays it to the strip chart.

4. Select Wavelength to monitor. Click Finish.

-
[A] Strip Chart Wizard

S

th Selection (3. from 5)

Steps Wi

1. Source Selection Range Selection

2. Update Rate

3. Wavelength Selection

4.  Select Numerator

5. Select Denominator ) One wavelength | 500.2/2] nm

@ Average from 499,55 to | 500.5%{ nm
() Integrate over 505.21% to 500.21%-| nm

Method Rectangle -

Information

Select either a single wavelength or range of wavelengths.

5. A new tab appears with the trend line.
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6.

The screen may need to be recentered. “Automatically scroll the trend line” will follow as
new data is collected. A FileWriter can be configured to save the trend line as above.

?] OceanView 1.3.4 (Licensed)
File Window Help

AP HOBRNG
(=] View_1 sﬁ‘AbsorbanceView

Sl 9
|

Trend_13 w\

lae ey *xg hEal & Q@0

ites

ﬁ] Favor

Note: the trend line only saves data temporarily. As a new data point is collected, the
oldest data point is deleted.

Importing Data to Excel

1.

Note: the macro to do the import is not robust. If you give it an input it doesn’t expect, it
can’t handle it.

On the desktop of the desktop computer in folder “File Writer Import,” open “CP-VI-
092.xIsx.” If anything is in the notebook, delete it.

Make sure cell A1 is selected.
Under View>Macros>View Macros

From the Macro screen, run “DoThelmport”

-

-
Macro Ll_Jﬂ e X
Macro name:
DoThelmport] £
Dotheimpot |

Step Into
Macros in: | All Open Workbooks E] |
Description 1

Cancel

!
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6. Select the files you want to import. They must be OceanView txt files with Headers. Use
Shift and Ctrl multiple files. Note: if you have more than 255 files, Excel cannot plot
them all together (and this will be very slow). For best results, divide amongst multiple

Excel sheets.
r Open

Tl

Organize v

New folder

. Kate Pitman -

1. Japanese Clips

4 Libraries
@ Documents
Jﬁ Music
[ Pictures
$¥ videos

< Homegroup

1% Computer
&, os(c)
&% DVDRW Drive ([ _

Absorbance_0000
1

Absorbance_0000
2

Absorbance_0000
3

Absorbance_0000
4

Absorbance_0000
5

Absorbance_0000
6

Absorbance_0000
7

r

=

F
e

Absorbance_0000

File name: "Absorbance_00007" "Absorbance_00001" "Al v [Text File

Cancel

M

Tools ~ [ Open

7. Select open.

8. The files will be imported into Excel. The wavelength column will only be copied from
the first file and is in Column A. Row 1 contains the time each spectrum was recorded.

H % &= CP-VI-092 - Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER ChemOfficel6
it 96 Cut Calibri ‘u CA =E=E - EWepre (Geneal -

B Copy . —
pafte ¥ Format Painter B I U v - DA === & 3= EMerge&Center + $ - % » G 0
Clipboard ] Font ] Alignment ] Number
AL - S
A B C D E F G H 1 J
ThulJun ThuJun ThulJun Thulun Thulun
ThuJun 02 ThuJun 02 02 02 02 02 02
08:50:40  08:51:10EDT 08:51:40 08:52:10 08:52:40 08:53:10 08:53:40
EDT 2016 2016 EDT 2016 EDT2016 EDT 2016 EDT 2016 EDT 2016

1 L]

2 |1.8996E2 -19.508E-2 2.08E-02 2.02E-02 -2.97E-01 -3.04E-01 2.62E-01 2.47E-01

3 1.90E+02 -1.95E-01 2.08E-02 2.02e-02 -2.97E-01 -3.04E-01 2.62E-01 2.47E-01

4 1.91E+02 -1.95E-01 2.08E-02 2.02E-02 -2.97E-01 -3.04E-01 2.62E-01 2.47E-01

5 1.91E+02  0.00E+00 6.16E-01 1.52E-04 -1.07E-01 9.46E-01 0.00E+00 0.00E+00

6 1.91E+02  3.70E-01 2.43E-01 -6.31E-01 -4.18E-01 0.00E+00 -4.72E-01 -4.65E-01

7 1.92e+02  0.00E+00 0.00E+00 0.00E+00 0.00E+00 -3.81E-01 0.00E+00 0.00E+00

8 1.92E+02 -1.40E+00 -8.35E-01 -1.25E+00 -1.04E+00 -1.04E+00 -9.18E-01 0.00E+00

9 1.93e+02  0.00E+00 -1.23E+00 0.00E+00 -2.11E-01 -8.86E-01 0.00E+00 0.00E+00

10 1.93E+02 -1.77E+00 0.00E+00 0.00E+00 0.00E+00 0.00E+00 -1.85E+00 0.00E+00
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9. A separate worksheet contains the data as a chart.

d s CP-VI-092 - Excel CHARTTOOLS 2 @ - & X
T3 HOME | INSERT  PAGELAYOUT ~ FORMULAS ~ DATA  REVIEW  VIEW  DEVELOPER  ChemOfficel6 ~ OFFCAT  DESIGN  FORMAT Sign in
o ) ) . ot

O Calibri (Body) - (10 ~ A" A Vrap Text Genera @ 3 H
ER Copy ~ - il
Paste P BIU-~ HoA- Merae & Conter Conditional Formatas Cell  Insert Delete Format . Sort & Find &
Format Painter = ud Formatting bl tyl - - - £ Clear~ Filter - Select~
Clipboard [ Font n Alignment Number Styles Cells Editing ~
S v
2.00E+00 -
+
r
1508400 y

\\/\'___—‘ —— Thu Jun 02 08:50:40 EDT2016
000400 - . ——Thuun 020851:10€DT2016

500 1000 1500 2000 2500 Thu Jun 02 08:51:40 EDT2016
020852:10 EDT2016

2016
—— Thu Jun 02 08:53:10 EDT2016

Chart8 | Sheetl ® 4 >

10. Save the Excel file under a new name. File > Save As > Your File Name. Save As type
can be set to “Excel Workbook” rather than “Macro Enabled Workbook”

References and Related SOPs:
e Ocean Optics UV Vis_SOP
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Appendix A. Code for import

Sub DoThelmport()
' This prompts the user for an array of FileName, assumes the
' separator is a tab, and then calls the appropriate sub to
"import the file. A sub is then called to make a chart.
Dim FileName() As Variant
Dim Sep As String
Dim Index As Integer
FileName() = Application.GetOpenFilename(FileFilter:="Text File (*.txt),*.txt",
MultiSelect:=True)
If Not IsArray(FileName) Then

"user cancelled, get out
Exit Sub
End If
'Defining the file at tab deliminated
Sep =vbTab
'Sep = Application.InputBox("Enter a separator character.", Type:=2)
'If Sep = vbNullString Then

"user cancelled, get out
'Exit Sub
'End If
'Debug.Print LBound(FileName) & UBound(FileName)
ImportFirstTextFile FName:=CStr(FileName(1)), Sep:=CStr(Sep)
'Steps through the array of files to import
For Index = 2 To UBound(FileName)
ImportNextTextFiles FName:=CStr(FileName(Index)), Sep:=CStr(Sep), Col:=(Index + 1)
Next
Rows(2).Delete
CreateChart traces:=(UBound(FileName))
End Sub

Public Sub ImportFirstTextFile(FName As String, Sep As String)
' This imports the first file (including wavelength) into Excel.

Dim RowNdx As Long

Dim CoINdx As Integer

Dim TempVal As Variant

Dim WholeLine As String

Dim Pos As Integer

Dim NextPos As Integer

Dim SaveColNdx As Integer
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Application.ScreenUpdating = False
'On Error GoTo EndMacro:

SaveColNdx = ActiveCell.Column
RowNdx =2

Open FName For Input Access Read As #1

While Not EOF(1) 'steps through the lines of the file
Line Input #1, WholeLine
If Right(WholeLine, 1) <> Sep Then
WholeLine = WholeLine & Sep
End If
"This ifThen is putting the time in the first cell
If InStr(WholeLine, "Date") > 0 Then
Cells(1, SaveCoINdx + 1).Value = Mid(WholeLine, InStr(WholeLine, "Date") + 6,
InStr(WholeLine, "User") - InStr(WholeLine, "Date") - 6)
End If
'for whatever reason the first data point got caught in the header. This pulls it out.
If RowNdx = 3 Then
Cells(3, SaveColNdx).Value = Mid(WholeLine, InStr(WholeLine, "<<<<<") + 5, 9)
Cells(3, SaveColNdx + 1).Value = Mid(WholeLine, InStr(WholeLine, vbTab))
Elself RowNdx > 3 Then
ColNdx = SaveColNdx
Pos =1
NextPos = InStr(Pos, WholeLine, Sep)
While NextPos >= 1
TempVal = Mid(WholeLine, Pos, NextPos - Pos)
Cells(RowNdx, ColNdx).Value = TempVal
Pos = NextPos + 1
ColINdx = ColNdx + 1
NextPos = InStr(Pos, WholeLine, Sep)
Wend
End If
RowNdx = RowNdx + 1
Wend

EndMacro:

On Error GoTo 0
Application.ScreenUpdating = True
Close #1

End Sub

Public Sub ImportNextTextFiles(FName As String, Sep As String, Col As Integer)
' This imports all following text files (only the 2nd column)
Dim RowNdx As Long
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Dim TempVal As Variant
Dim WholeLine As String
Dim Pos As Integer

Dim SaveColNdx As Integer

Application.ScreenUpdating = False
'On Error GoTo EndMacro:

RowNdx = 2
Open FName For Input Access Read As #1

While Not EOF(1)
Line Input #1, WholeLine
'Having this in here was leading to a tab at the end of the value so Excel read it as text.
'If Right(WholeLine, 1) < Sep Then
'WholeLine = WholeLine & Sep
'End If
'This ifThen is putting the time in the first cell
If InStr(WholeLine, "Date") > 0 Then
Cells(1, Col).Value = Mid(WholeLine, InStr(WholeLine, "Date") + 6, InStr(WholeLine,
"User") - InStr(WholeLine, "Date") - 6)
End If
Pos = InStr(1, WholeLine, Sep)
TempVal = Mid(WholeLine, Pos + 1)
Cells(RowNdx, Col).Value = TempVal
'Debug.Print (TempVal)
RowNdx = RowNdx + 1
Wend

EndMacro:

On Error GoTo 0
Application.ScreenUpdating = True
Close #1

End Sub

Sub CreateChart(traces As Integer)
'PURPOSE: Create a chart with all traces from Ocean view data
If traces <= 255 Then
Dim rng As Range
'this assumes that the data starts in A1 and is comming from OceanView with 2048 data
points
Set rng = ActiveSheet.Range(Cells(1, 1), Cells(2048, traces))

Charts.Add
ActiveChart.ChartType = xIXYScatterSmoothNoMarkers
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ActiveChart.SetSourceData Source:=rng, PlotBy:=xIColumns
End If
End Sub



